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7.2 Managing exposure – Levels 

For advanced exposure adjustment, it is recommended that levels are 
adjusted first, followed by curves. The curves tool has been designed 
not to clip image information and will only operate on tones within the 
defined white and black points of the image.

What are correct settings for Levels?
In an ideal situation, levels should be adjusted to slightly clip the end 
points of the image histogram at the shadow end and to the maximum 
highlight level on the right side of the histogram.

The images below show before and after adjusting the levels for  
an image.

You can see that the black point and white point adjustments have 
been brought in very slightly. This has the effect of lightening the lighter 
tones and darkening the shadow tones in the image, at the same time 
increasing contrast slightly. The process has to be done very carefully 
in order to preserve the feeling that the image evokes.

The highlight warning function (view>enable exposure warnings, can 
be configured to provide visual feedback when adjusting the Levels.

Once the highlight and shadow points of the image have been fixed, 
the density or mid-tone values of the image can be adjusted using the 
centre or gamma slider on the levels tool.

Highlight warning shows where the 
levels should be set – here app 245

Tip:
The fastest way to use levels is the auto 
tool as a starting point – this will not clip 
information – if the result is not desired you 
can fine tune the result manually.
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When do I use Highlight and Shadow picker?
The white point and black point pickers are best used in the context 
of ‘controlled’ studio images where, in conjunction with a quality color 
chart, they can be used to precisely set the black and white points of 
an image.

Custom Target Levels
Custom Target Levels extend the abilities of the levels tool, enabling the 
means to control the output values and to reduce contrast in the image. 
This is particularly useful where an image has data in the highlight area 
that is in danger of clipping. The theory is that you set the target level to 
the desired value and then use the picker tool to choose the area within 
the image that you wish to match that brightness level.

With conventional pixel based image tools, output levels are used 
to compress the tonal range of the image to fit in a smaller space, for 
example re-mapping highlight values of 255 to 245. Whilst this prevents 
clipping, it means that there is a sharp cut-off of image data, leading to an 
hard transition between data and no data when the image is re opened.

Capture One Target Levels work in such a way that the tones are 
remapped, yet avoiding hard transitions in highlight areas and resulting 
in pleasant, more natural looking images.

How do I use custom target levels?
Set a desired value for an area in the highlight area of the image where 
it is important to retain detail; for instance 240.

Select the white point picker tool from the Levels Tool Tab and then 
‘pick’ the highlight area within the image.

The same process can be repeated for shadow values and the black 
point picker.

ADVANCED USE ONLY:
Preferences allow these values to be set for every image in Pick Target 
Levels. Do not do this unless you really understand the implications.
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7.3 Managing exposure – using curves

How do I work with curves?
Levels are used to control the overall tonal distribution of an image. 
Curves provide the ability to remap the area within the shadow and 
highlight limits set by the Levels tool areas to produce a desired image.

There are certain ‘classic’ curves that are used in image applications to 
achieve specific results in images. Best known is the “S” curve which is 
used to increase contrast in an image.

The S curve achieves the increase in contrast by pulling down the 
shadow values, normally on the quarter tones and increasing the values 
of the tones at the three-quarter tone mark as shown in the image.

The brightness values at the quarter tones, before applying the curve, 
are around 65 (with image tonal values from black 0 to white at 255). 
The curve darkens these tones to around 50, whilst the three-quarter 
tones at 190 are raised to 200, lightening them in the final image.

The inverse S curve has the opposite effect of lightening the shadows 
and darkening the highlight tones, causing a reduction in contrast.

For advanced use, the Pick Curve point picker tool (p) can be used to 
pick a specific tonal area within an image. This value is added to the 
curve to allow adjustment of the values for that part of the image.

The image below clearly shows how the value picked on the image 
translates to the image curve.
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7.4 Managing exposure – using High Dynamic Range tool

The bulk of image adjustments can be done with the exposure slider 
and the levels/curves tools.

There are two scenarios where the High Dynamic Range tool may prove 
to be essential.

In certain situations, image contrast is such that clipping may occur 
at both ends of the histogram. In such cases the HDR tool provides a 
means of optimizing the image to deal with the extreme contrast and 
prevent the clipping of highlights and shadows.

High Dynamic range also provides the means to make use of images 
that have been accidentally over or underexposed to an extent that 
render them unusable with conventional exposure tools.

How can I optimize the dynamic range of an image?
The dynamic range of an image is optimized at the shooting stage by 
adjusting exposure to capture the maximum amount of data. This may 
result in an image that does not look optimal on the LCD display.

Bear in mind that around 1/2 - 1 stop of additional data can be recovered 
from overexposed highlights.

Once the image has been opened in Capture One, it is optimized by 
using the various tools within the software to adjust the data. The High 
Dynamic Range tools can help with ‘difficult’ images, where contrast 
is extreme. Applying a soft-proof profile for the output should be 
configured in order to edit for this output device.
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7.5 R-G-B Levels and curves

Can I control the level for the individual color channel?
RGB levels will allow you to change the levels including target levels 
per color. You can use this feature to create a special look, or provide 
a desired tone of color, but most important is using this feature to 
enhance some of the colors, without creating a “pumped” look on the 
image files.

How can I neutralize the shadow area in my image file?
Should your shadow area be showing a not-desired tone of color, you 
can achieve a more natural look by using RGB curves, this will work on 
the individual tone of color value Red, Green or Blue in all in shadow or 
highlight.
 
How can I get more clean colors?
Not unusually you will experience doing shot outdoor, that are showing 
a shade of color from the e.g. the sun.

This color shade would in the image example make the grass look 
brown-ish – to avoid this, you could add green either by using advanced 
color tool tab, or by pushing the green mid-tones in the R-G-B levels, 
both will however possibly leave the model, here the players, in a light 
not comparable to the green grass. 
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How can I lighten shadow areas in an image & how can I darken 
highlight areas in an image?
A good way to adjust the shadows and highlights in your image is with 
the curves tool.

Use the Pick Curve Point tool (u) to click in the area of the image to be 
adjusted. A point will be put on the curve and this allows very precise 
adjustment of the exact tonal area of the image that you prefer. To fine 
tune this, use the arrow keys on the keyboard. This practice is much 
more accurate as compared to relying on the sliders in levels to achieve 
an overall result.

How can I prevent highlight and shadow detail loss?
Correct exposure in combination with the dynamic range tool, where 
necessary, prevents highlight and shadow detail loss.
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7.6 Styles

Besides creating instant “looks” styles is a true money-maker.

How do styles work on my image?
Styles is a combination of presets added at once to provide 
your photo a certain look, this will save loads of working hours 
in post process. The changes will be seen as soon as you mouse-over 
the style, but will only be applied as you click on the style. 

Styles do not add or change your image in any way you couldn’t have 
done on the various sliders. But by adding the style, you only have to 
polish the photo afterwards. 

If you apply more than one style it is important to keep in mind, that 
the latest applied style will override the previous applied style, if the 
values exceed the previous style. -If the values do not exceed the 
values of the former applied style, the former style will still be partly 
visible on the photo.

The values of the style are not placed “on top” of the previous values 
– the highest value replaces the lower value. Remove a style by 
entering the style drop-down-menu, the top area of this will show 
a list of added styles and the possibility of removing these as you 
mouse-over these menu items the photo will be live updated to show 
the changes.  

Exposure Brightness Contrast Saturation
Adjustments 10 -10 7
Result 10 -10 7

Exposure Brightness Contrast Saturation
Style 1 8 -5 9
Adjustments 10 -10 7
Result 8 -5 9 7

Exposure Brightness Contrast Saturation
Style 2 6 10
Style 1 8 -5 9

Adjustments 10 -10 7
Result 8 -5 6 10




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Can I create and save my own style?
When you have created a look to your photo that you want to keep, 
copy the adjustments, and decide which changes to keep in the style, 
it is recommendable to not e.g. include White balance in a style.  

When you have check-marked the adjustments you prefer to keep in 
your new style, press on the Styles button and choose “Save As Style” 
the Save Style window will allow you to save the style where you want, 
but the Styles folder will let Capture One find the style, all styles work 
across sessions and platforms.

Name your style a recognizable name and you will find the style in the 
Styles Drop-down menu, below the default styles.

How can I transfer and share styles?
Styles saved, will be stored in the Styles folder, commonly placed on 
the Mac path Library>Application Support>Capture One>Styles; the 
Style file will be a “.costyle”, this file can be copied to other computers, 
and works cross-platform. 

How can I modify a style?
When you have applied a style, and still want to change to attain the 
effect you want, polish the image until perfect – and copy the settings, 
save the style, save using a new name, to not over-write already made 
style.

How can I see if a style is applied to an image?
The applied style will do no “hidden action” on your raw-file, it is merely 
a set of adjustments, hence you can see the changes, and modify these 
on the regular tools such as saturation.

Easier is checking the Styles drop-down menu, above the Default styles 
you will find the applied styles on the primary variant. The styles is 
listed with the last one applied on top of the rest, the bracket indicates 
if the previously applied style is Adjusted or partially or fully overridden.
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If the images have different white balance or exposure – Will a settings 
copy be absolute or relative?
Any settings copied from other images are absolute. For instance if your 
white balance is currently tungsten, 3500K and you paste a daylight 
balance from another image, the setting will be an absolute one; it will 
not be halfway between tungsten and daylight.

Can I save the settings with the RAW files?
Capture One saves all settings in a subfolder called “Capture One” in 
the same folder as the RAWs.

All changes made to a RAW file are saved in a .COS settings file. This 
file is located in the Capture One folder with the RAW files. This file 
contains all the information regarding edits made to the RAW file.

The Cache folder is also found here. Within this folder is a Proxies 
folder. In the Proxies folder there are .COP files. These are the previews 
viewed in Capture One.

Settings files from previous versions cannot be read by Capture One 5.

Even easier is to save as .EIP, this only applies for Phase One digital 
back users. Read more about .EIP in the chapter on this.

8.0 Image settings

How do I copy settings from one image to a group of images?
Choose an image and make all the necessary adjustments to it. When 
finished click the Copy button and check the Adjustments Clipboard 
Tool Tab. Choose “Select Adjusted” There will be a list of settings that 
have been applied to the image.

Next to each setting, there is an orange check or tick. If you wish to 
apply all changes to other images, leave all the boxes checked. If you 
prefer to apply only a subset of the changes, deselect the options not 
required.

Go to the browser and select the group of images that you want to 
apply changes to. Click on the Apply button and paste the settings 
into the selected image. To apply settings to multiple images, selct 
these and choose Adjustments>Apply Adjustments

How can I ensure the same look between images?
First of all your of course have to have the approximately same 
exposure values, then make changes to one and then use Copy 
Adjustments and Apply Adjustments to to paste the settings to the 
other image files as described above. If you are Capture One 5 PRO 
user, you can also use styles.

Preset is a clever way of creating shortcuts in the daily work, instead 
of repeating your corrections again and again, save the preset, and 
get a precise and easy adjustment. 
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9.0 Variants

Introduction
A variant is actually a copy of the settings used to create an image 
preview; it is not a duplicate of the original file. This means that it is 
possible to create multiple image variants without using any significant 
disk space.

Variants provide an easy way to try different settings or modify the 
work you have done on an image without risk. Original image data is 
untouched by any changes made.

How can I create different expressions from one image?
Variants provide an easy way to try different settings or modify the 
work you have done on an image without risk and without copying your 
image files.

New Variant creates a duplicate of the image using default settings. 
The image is created as it came out of the camera or DNG file except 
rotation.

Clone Variant creates an exact duplicate of the image you are working 
on; complete with any changes you have made.

Tip:
You have adjusted the exposure, stopped the highlight 
clipping and fine tuned the shadows when you want to make 
a BW copy black and white image:
No problem: Create a clone variant, go to Quick Tool tab > 
Saturation and set saturation to -100.  
– Alternatively, choose a Black and White profile in Profile 
pull-down.

Tip:
The white frame 
of one image in 
the Viewer shows 
you which image 
you are working 
on in this case 
you work on the 
original NOT the 
Variant.

Note:
When you change 
an image to BW 
the Histogram 
and Levels 
automatically 
switches to 
monochrome
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How do I delete Variants?
The easiest way to delete a Variant is marking the variant in the Viewer 
or browser and press Delete or on PC press Backspace. You can also 
right-click and choose Delete from the menu.

When a Variant is deleted, only the settings file for the Variant is deleted. 
The original image file is untouched.

What settings does a Variant inherit from the original image?
Normal Variants inherit the raw default settings from the original image 
+ metadata and Lens Cast corrections (where appropriate with Digital 
Back files).

Clone Variants inherit all settings from the original image, including 
white balance, color, exposure and other changes that have been made 
in Capture One. 

With the exception of Lens Cast correction (Digital Backs only) and 
Metadata, any changes made to an original image can also be applied 
to a variant. Lens Cast is a special case, as it is regarded as a correction 
of the original image. That correction is applied to the original and 
automatically applied to any variant.

When creating a variant, metadata information is not changed because 
the content and the creator of the image have not changed.
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9.5 Lens Correction Tool - RAW ONLY!

The Lens correction tool is a brand new way of working on classic 
optical issues, like distortion, light fall off and purple fringing.

As light travels through any lens it will be bend, there are several ways 
of trying to avoid the bending lines or loss of sharpness; Apo chromatic 
lens elements, highly sophisticated coating and advanced lens groups 
can “only” lower the effects of the bended light.

Phase One R&D have created special profiles for a series of lenses from 
studying the light, this evolved into the Lens correction tool.

How can I correct bended lines?
It is not unusual experiencing bending 
lines especially when photographing 
architecture, there are large differences in 
the capabilities of lenses, but it is natural to 
experience bending lines. 

If your lens is already known by Capture One PRO, corrections will 
automatically be added as the image is loaded, you decide however, if 
you want to edit the corrections or you can remove them completely by 
removing the check-mark.

If Capture One already knows your lens, it should not be necessary to 
do further corrections, still it is possible to edit the applications preset 
manually by using the sliders.

Automatic corrected
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Why are the sliders not active?
Sharpness and light fall off will only work if 
Capture one already knows the lens used, 
this is due to the fact that these tools are 
created upon optical knowledge about 
specific lenses.

If the light fall off is not active try the vignetting tool in 
very small doses or the high dynamic range tool.

Can I correct the image if my lens is not yet known by Capture One?
If your lens is not recognized by Capture One, you can create your own 
correction based on distortion and Chromatic Aberration analysis and 
purple fringing. For each focal length you work with you can choose 
to save these changes as a style, and thereby create your own lens 
correction, you should however be aware that a change in aperture 
values can make a difference in how the light is travelling through the 
lens.  
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What is Chromatic aberration, and can I avoid it?
Photographers will from time to time experience different light and lens 
related flaws, like chromatic aberration, Capture One includes features 
to reduce such undesired effects.

Chromatic aberration occurs because light is divided in many 
wavelengths.  The light waves will react slightly differently when passing 
through the lens, therefore the light will have slightly different exact 
focus points, as the light is enlarged slightly different by the parts of 
the lens.  The light will often pass perfectly through the midst of the 
lens, but the further to the edge of the lens, the larger difference of the 
enlargement when the light waves enters the chip or film.

As chromatic aberration is different from lens to lens, the lens correction 
is not “just” removing color appearing to mismatch, the chromatic 
aberration feature is created to act according to the combination of our 
knowledge on the single lens and an analysis of the image thereby the 
software will surgically remove the chromatic aberration where possible 
without affecting the surrounding pixels. 

The Chromatic Aberration ‘filter’ currently supports Mamiya 
and Phase One lenses in combination with the Phase One camera (or the 
Mamiya AFD) and a Phase One digital back.

If you want to minimize the chromatic aberration zoom to 400% on your 
image to check the effect, and press Auto-button and shortly after the 
chromatic aberration is minimized.

Purple Fringing is an effect which looks similar to the chromatic 
aberration and is also caused by the different  exact focuspoints in the 
red wavelengths compared to the rest; this feature automatically, checks 
for the effect in high contrast areas, like when using the Chromatic 
Aberration feature.
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How can I avoid color errors when photographing shining or high 
contrast motives? 
Brass, Chrome and many metallic products can provide purple fringing, 
this happens as the wavelengths of the light have slightly different focus 
points; Purple Fringing is related to Chromatic aberration and both are 
seen when you have high contrast motives.

Purple fringing is very clear on this image, you should go in 100% to 
check the result, and simply check-mark purple fringing and this will 
get rid of the issue. 

Chromatic aberration will often be seen on both sides of the white 
pixels on black background as purple/pink and green on the other side, 
to avoid Chromatic Aberration, check-mark in the box, and Capture 
One will automatically find the pixels showing chromatic aberration and 
neutralize the colors of these.
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Can I control the shape of Vignetting?	
Capture One provides more options on vignetting, you can choose 
circular or elliptic, both variations will now be adjusted to you crop, not 
the complete image file. Remember using the local copy function, to 
adjust many images.

Can Capture One read vignetting from previous versions?
Yes, the new Vignetting tool is made to accept the vignetting added to 
your imagefile in previous versions, in that case you will have the circular 
vignetting, you can always change this to one of the new options.
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9.6 Lens Cast Correction

What is Lens Cast?
Lens cast is a commonly known lens issue, creating darker areas 
towards the edge of the lens, this occurs as the light are entering the 
individual glass in your lens, the more glass and groups the higher risk 
of visible lens cast.

What is Lens Cast Calibration?
Capture One is equipped with one of the most powerful core engines 
in the market, by an analysis of the Lens Cast shot Capture One will 
determine the need of correction, keeping the correction smooth and 
natural.

What Lens types are supported?
A large variety of lenses needing correction is already supported; these 
analyses have been made by Phase One R&D and covers different Carl 
Zeiss and Hasselblad lenses. More lenses will come in time, but it is 
very easy conducting your own analysis. see the list in lens correct - all 
lenses supported are found in presets of Lens Correction tool tab

How do I create my own Lens Cast Correction?
Lens Cast is a well-known issue especially on large format and on 
wide-angle lenses. Capture One is providing and easy 2-step lens cast 
correction tool placed in the Lens Tool Tab.

First do a lens cast correction shot, using a calibration plate, import the 
image to Capture One and choose analyze in the LCC drop-down menu.

You will automatically be asked to name your new LCC profile, used a 
recognizable name, reference to the lens, focal length and aperture, as 
you will need LCC filters for all Apertures and focal lengths if possible.

When the analysis is done the LCC profile will be saved and you will 
find your personal LCC profiles in the LCC drop-down menu.
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10.0 Compose your image

Introduction
Image Composition in Capture One is the area where images can  
be straightened or rotated and then cropped precisely to fit layouts  
and prints.

Cropping of an image can be done freehand or with the constraints 
of specific ratios such as popular photographic paper sizes. A grid 
is provided to facilitate alignment and there is the option to display 
labels, with dimensions related to the selected output destination. 
Controls for this are available in the preferences (Preferences > Crop 
> Show labels).

In combination with the output tool, images can be cropped to specific 
sizes for output. 

The rotation function is geared towards straightening of images where 
object or horizons are not as vertical or horizontal as was intended. 
As the rotation is applied, the image is automatically cropped to the 
maximum usable dimensions.

Use cursor arrows to move or edit crop area
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10.1 Crop tool

How do I crop an image?
To crop an image, select the crop button in the Composition tool panel 
or the cursor tool selector. 

To quickly free crop an image, make sure that ‘Unconstrained’ is 
selected and simply drag a crop frame in the image area. Depending 
on the preferences that have been set, there will be a semi-transparent 
mask hiding the area that is being cropped. The dimensions will indicate 
the size of the cropped image.

To view the cropped image, select another cursor tool and the image 
will be shown in its final form. You can still see the original image with 
the cropping mask in the thumbnails. Re-selecting the crop tool at any 
time will allow adjustment of the crop settings.

The best practice is to drag the edges of the preview inwards (the cursor 
will turn into a two-way arrow) until the desired crop has been achieved. 
To reposition the cropped area, click in the middle and the button will 
turn into a cross. Move the cropped area. When the desired result has 
been achieved, select any other button from the cursor tool selector. 
The crop will be applied and the updated preview will fill the viewer.

How can I reuse a crop setting from an image to other images?
Once an image has been cropped the settings can be copied and 
pasted to multiple images in the same way that other settings can be. 
Adjustments > Copy Adjustments and then select other image(s) and 
Adjustments > Apply Adjustments. 

How can I set a crop aspect ratio?
Select one of the predetermined Aspect Ratios from the drop-down 
menu. Your crop will automatically be constrained to these aspect 
proportions. When you make a crop in an image the crop orientation 
(landscape vs. portrait) will automatically switch to maximize the crop 
area staying within the aspect ration constraints.
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How do I switch crop sizes on and off?
The crop size can be switched off by going to 

Crop > Ratio > Unconstrained 

Alternatively, it can be turned on by selecting a crop ratio.

How can I change the crop masking?
The crop masking can be changed in preferences. Preferences > Crop

Here it is possible to change both the opacity and the brightness of the 
mask being used.

How do I revert to the uncropped image?
If you click Adjustments>Reset or Reset adjustments button the 
cropmask disappears.

10.2 Crop Settings

To create new crop settings:
Select Ratio > Add Aspect ratio. Name the crop in a meaningful  
way and then type in the ratio. For example new ratio – ‘10x8’, Ratio 10 
x 8. Another might be called ‘Square’. By setting the ratio to 1 x 1, every 
image would be cropped to a square shape. 
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10.3 Crop to output

How does Crop > Ratio > Output work?
This gives a similar result to using a crop ratio with a fixed destination 
as above.

Go to the output tool and select an output size, let’s say 5x4”

Select the crop ratio as output and everything that you crop will now fit 
within 5 x 4”. One of the neat features about this setting is that the crop 
automatically swaps between horizontal and vertical as you drag in the 
image. This allows the option to crop to a horizontal or vertical shape 
according to what works the best.

How does the crop settings work with outputting to fixed dimensions?
The most precise way to crop an image to an exact size is to set process 
recipe to, the output desired, i.e. 10x10. Create an aspect ratio that is 
the same dimensions of the desired print size. For example, an 8 x 10 
print is desired. I will create an aspect ratio that is 8 x10. Consequently 
when I apply a crop, the crop will fit an 8x10 sheet of paper regardless 
or image orientation.
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10.4 Straightening

How can I straighten images?
Nothing is more irritating than an image where the horizon is just a few 
degrees away from horizontal or a vertical building that is crooked. 
Capture One was the first RAW workflow software to allow rotation. 
Capture One 5 now offers an even more sophisticated straightening tool.

How do I straighten an image?
Select the Rotation/Straighten button in the cursor tool palette or in the 
composition tool and drag along a straight edge that should be vertical 
or horizontal. Fine tune the straightening or rotating by mouse scroll over 
the slider, this way you will change the degree of rotation by 0.1 at the 
time if carefully scrolled.

If I need to straighten an image, when should I crop?
It is easier to rotate the image first, as the software automatically crops 
the rotated image to the maximum usable dimensions. Following this, 
the crop can be fine tuned by the user, perhaps to fit to a specific 
aspect ratio such as 6x4 inches/10x15cm.

Can I apply straighten or crop settings to a group of images?
Straighten the image as required, optimize the crop and then copy the 
settings using the Copy/Apply buttons on the menu bar.

Select the next image/group of images that you want to apply the same 
settings to and click the Apply button. To apply to a group of images, 
first copy adjustments, edit the copied adjustments inAdjustments 
Clipboard Tab then select the imagefiles you wish to apply the crop 
and identical crop and rotations will be applied to all images.

To enhance the functionality of the copy and paste settings, it is possible 
to select which of the settings are pasted – see the Settings chapter for 
a full explanation of this feature.

Straight lineguide
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Rotate Freehand
To adjust the image by eye, move the slider on the angle tool to left or 
right. A grid appears, making it easy to align vertical or horizontal lines. If 
you wish to freehand rotate more images at once, firstly freehand rotate 
one image, then use Copy/Apply Adjustments.

Capture One allows adjustments up of to 45 degrees. For adjustments 
greater than this, use rotate left/right.

Rotate Left/Right 
Allows rotation of 90 degree to the left or right. By pressing shift while 
rotating Left/Right you will rotate all selected image files. Fine tune the 
rotation or rotating by mouse scroll over the slider, this way you will 
change the degree of rotation by 0.1 at the time if carefully scrolled. 
Rotate more than one image at the time, by first selecting the images, 
then simply pres Rotate icon.
 
How do I revert to the uncropped image?
Undoing any change in Capture One is performed by using Edit>Undo or 
of course the Undo button. In the rotation tool, it is possible to select the 
reset button or you can use Preset drop-down menu > Rotate snap 90˚.
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10.5 Checking Sharpness

How can I check the sharpness without zooming?
The Focus Mask is perfectly suited for the portrait and fashion 
photographer. Focus mask is a guide to the sharp areas of 
your image files this way you can check the entire image 
file without having to zoom in and out constantly. the Focus Mask is 
applied both to the image(s) in the viewer and the thumbnails in the 
image browser.

The default Threshold setting will normally provide a correct marking of 
the areas of your image that are in focus. The sensitivity of Threshold 
can be changed, if you prefer a more narrow judgment of the area in 
focus just adjust the Threshold sensitivity for a lower value, if you want 
a wider judgment let Threshold sensitivity be of a higher value.

You can create presets to match your preferred settings, to avoid 
redoing the adjustment of the tool.
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How can I check the sharpness of my capture?
You have the option to check the sharpness of your image file by 
watching checking at 100% in the viewer, but with the Focus Tool you 
have a very clever tool to assist you without having to zoom in and out 
in the viewer.

The Focus Tool will allow you to check a defined area in a zoom 
percentage of your choice e.g. 100%. The Focus tool can be placed on 
any tab you prefer by right-clicking on the individual tab – or you can 
have the tool free floating.

Select the Focus Point picker in the cursor tools or in the Focus Tool 
window and select the area you want to check. 

Then use the zoom slider or click the portrait icon to select 100%. The 
focus window will now automatically update any new shot when you 
select it – to show the sharpness of the same area on each shot.

If you are working on multiple image files the focus tool will refer to the 
primary image file, Focus Tool is working the same way on variants the 
Focus Tool is reflecting the primary variant.
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Tip:
When using Pan[H] – 
doubleclick anywhere 
on the image an the 
area you click on will 
go to 100%

10.5 Sharpening

Sharpening is an essential process when working with images created 
by digital cameras. The Capture One sharpening is a newly designed and 
enhanced unsharp mask. The purpose is to compensate for the effect of 
internal filters in all DSLRs that soften the image and to compensate for the 
softening effect that occurs when the images are printed.

By default, Capture One sharpening settings have been configured 
to provide a good looking image on screen. Additionally, the software 
comes with a number of presets that are accessed from the pull-down 
menu. Any of these presets can be activated and set as a default for 
all images. 

When an image is destined for post-production or retouching in other 
software, it is recommend processing the image without sharpening applied.

How do I sharpen an image?
Capture One has a range of presets, formulated to provide good starting 
points for sharpening images for most purposes.

If the concept of sharpening is unfamiliar to you, take a little time to 
look at how the settings change the appearance of images on screen 
at 100%, and compare these to final prints. 

Typically, an image that is sharpened, for print or press, will look overly 
sharp on screen but produce a pleasing result when printed.

What settings are needed for Inkjet printing?
Inkjet printers vary, from small desktop models, to ultra-wide, large 
format machines. 

Start with the supplied inkjet setting, check the result and if desired, 
adjust. If you modify the settings, then the new settings may be named 
uniquely and saved as a preset.
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What settings are needed for printing in a magazine or brochure?
If your images are processed for later printing it varies how much 
Sharpening is needed, a good starting point would be:

Amount: 350
Radius: 0.9
Threshold: 2

Fine tune this to suit your needs and the recommendation from the 
printing place and save as preset.

How can I see the effects of the sharpening?
The effects of sharpening and noise reduction are shown as they will 
appear in the final image, in the viewer. 

Zoom to 100% either by using the Zoom tool – or if you are using the 
hand cursor just double-click where you want to check details.

When you at 100% it is easy to see the changes as you work with the 
detail tools.

How can I determine what’s the right amount of sharpening?
A rule of thumb for sharpening used to be that the image should look 
over-sharp on screen to look correct in print. These ideas have been 
superseded. 

The current thinking is that a 2 stage workflow is better. First sharpen 
the fine detail in the image.

Use the capture or raw pre-sharpening setting. 

Secondly, a more aggressive sharpening affect can be used. This should be 
applied when the image has been sized according to printing dimensions. 

There is no accurate measure of ‘what is the right amount’. Sharpening 
is a skill that is learned over time.

If you feel insecure on the right amounts of sharpening, try out one 
of the many Sharpening presets, after selecting the preset, you can 
always edit the parameters further

Can I turn off image sharpening?
Turn sharpening off by selecting ‘Disable Sharpening’.

There is no sharpening applied behind the scenes.
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10.6 Noise Reduction

Luminance noise exists in every digital image. This noise is caused by 
the light sensitive chip, regardless of ISO. Normally this noise is more 
visible at high ISO values.

Higher Noise levels at high ISO values are caused because the signal 
has been amplified.

Luminance
Removes the pattern-like noise often present in shadow areas. Best 
practice is to set Luminance to 25, even for low ISO images. Images 
with noise that is displeasing increase the setting value and check the 
effect in the Viewer at 100% magnification.

Color
Removes color noise from images, typically noticeable as subtle green/
magenta patterns. It is very difficult to recommend specific settings as 
noise varies from camera to camera, but the program defaults provide 
a good starting point. The viewer provides a clear view of the effect of 
filters on image noise.

How can I remove noise from images?
Noise should be removed from the images using a combination of the 
above tools. Capture One automatically applies some noise reduction 
to images, based on the ISO and exposure data from the camera that is 
contained in the image metadata. The default settings provide a good 
starting point for further adjustments.

What kind of noise can I remove in Capture One?
Capture One allows the removal of luminance and color noise from 
images using the color and luminance noise reduction sliders.

Tip:
Use the default setting (applied automatically 
by the software) and then zoom into 200% to 
fine tune settings for an image – if you have 
a group of similar images, apply the resulting 
setting to all images or create a new preset.

Tip:
Both sharpening and noise reduction tools 
allow the user to create presets, making it 
extremely easy to create regular settings for a 
specific camera or type of image. Simply click 
the preset button and select ‘add preset’ to 
create a new preset.
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PRO
Feature

How can I raise contrast in hazy or low contrast images?
Contrast is one of the variables to be used when adjusting hazy images, 
but the new PRO tool Clarity has proven to be an extremely effective 
tool.

Clarity is adjusting contrast and slightly also sharpness on basis of pixel 
frequency. This is done in relation to an analysis of the image made by 
Capture One PRO.
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PRO
Feature

How can I avoid Moiré?
In very simple terms Moiré can occur, when you are capturing a motive 
with fine pattern details, which the sensor lack resolution to reproduce.

Moiré can be an issue when photographing clothes and with 
architecture photography.

Often the simplest way to avoid Moiré is to moving back/forward a bit while 
photographing and/or changing aperture.
 
Start by providing a small portion of amount, just until you see an effect, 
then ad pattern until you see a change and then finish with more amount. 
You need to handle this with caution as too much of the Moiré tool can 
interact with lines and  colors you do not want affected.
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10.7 Dust and spots

How do I get rid of dust on my images?
Dust is not uncommon when you are using medium format, of course 
a lot can be avoided, by using air, and keeping the protection plate on 
the back as clean as possible, still the chip creating the image is by far 
too sensitive to not see a tiny, tiny dust particle. 

Removing dust particles from images can be a demanding task, but 
using the Dust removal tool, will let Capture do the hard work.

Mark up the dust spots on the image using the spot cursor tool.

The size of the spot cursor tool can be adjusted by pulling the sides 
of the cursor tool circle, the sport cursor tool is moved by placing the 
cursor inside the circle and moving it.

Choose dust in the drop-down menu.

You can have as many dust removal markings as you need, switch 
between the individual removal circles in the spot drop-down menu, 
the selected marking will turn orange - this way you can change a circle 
from dust to spot removal.
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11.0 Metadata 

Introduction
Metadata is a term that means data about data. In photographic terms 
it refers to data that describes your image and how it was taken.

Metadata in Capture One can be broken down into two types:

Basic
Basic is a subset of IPTC, data that is regularly used by photographers 
to add captions. This area provides the ability for the user to add 
Copyright and Caption information to the image. In the browser it  
is also possible to rate the image and this will be shown in the  
metadata window.

EXIF
EXIF information is data that is embedded into the file by the camera 
and is not editable by the user. Capture One shows two types of  
EXIF data.

EXIF Exposure data includes shutter speed, ISO, aperture and all other 
user configurable settings.

Importantly, it includes white balance information according to the 
camera at the point of capture. This directly affects how the thumbnail 
and preview are displayed in Capture One EXIF Camera data provides 
comprehensive details of the hardware used, detailing the body (or 
digital back), lens and serial number.
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11.1 What Meta data can I enter/change?
You can change the Basic metadata, filename, rating caption and 
copyright. You can set Caption & Copyright information when you 
import the images, this can later come handy, when producing Web 
Contact Sheets. 

After import of the image you can change the metadata on the Metadata 
tab click on the line, to activate the IPTC field you wish to change. If 
you choose to rate your images this rating will also be a part of your 
metadata, this will help the future users of the image when they need to 
sort or search in the images.

If your images have had metadata added when capturing, these meta 
data will appear if your choose to not change the data, if you choose to 
change them, the change will be in the settings file, not directly in the 
RAW or image file

How can I search for images with specific metadata/Exiff data?
Within the Browser Toolbar, there is the option to show image thumbnails 
or to view images as a list.

First, choose to view thumbnails as a list. This is the best way to sort 
images. From the View pull-down menu choose sort. The sort pull-
down menu offers various metadata and Exif data to choose from. 
Sorting method is ascending. If descending values is desired simply 
click no the header title and the order is reversed.
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11.2 What IPTC keywords can I add?
The IPTC, based in London, UK, is a consortium of the world’s major 
news agencies, news publishers and news industry vendors. It develops 
and maintains technical standards for improved news exchange that 
are used by virtually every major news organization in the world.

Read more on IPTC

IPTC keyword can be created to allow future holder of the image file 
capability of determining ownership, geographical notes and many 
other keywords.

The titles of the individual IPTC fields can change from application to 
application, only the coding are a standard, the naming in Capture One 
might therefore look different e.g. Creator in Capture One might be 
Author in another application.

How can I create IPTC recognizable keywords?
It is possible to add various keywords for your image files in the 
Metadata tab. Contact info, content, image info, Keywords and status.

You simply select the header you wish to add keywords for and the 
field will be active, when you select another field the added keyword 
are automatically stored.

Besides the dedicated IPTC fields you can add your own keywords – 
press the + sign next to the header “IPTC – Keywords” and you can add 
your own keywords, and you can add as many as you prefer – if you 
wish to delete an already entered keyword just press the minus to the 
right and the keyword will be deleted

How can I enter the same keywords to many image files?
When you are done adding the necessary keywords press copy 
adjustments button, go to adjustments clipboard by selecting Metadata, 
you can select any individual by adding checkmarks. 

http://www.iptc.org/cms/site/index.html;jsessionid=aRj8m8lN6W09?channel=CH0090
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When your selection of metadata is done, deselect other corrections as 
these otherwise will be applied to your images if not deselected.  

Now select the images you want to apply metadata to and press the 
apply adjustments button, the metadata is now applied to all selected 
images.

Read more on copy and apply adjustments in the chapter “Image 
Settings”.
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12.0 Get the right output

Introduction
Images can be processed from Capture One as TIFF or JPEG files, with 
options for file compression, bit depth and color space, in addition to 
the normal options for resolution and size. 

There is also the option to create contact sheets for web use. 

For archival use, Capture One can export images to the open standard 
Digital Negative, .DNG files. 

Images intended for manipulation or post production in other software 
should be exported as 16-bit TIFF files in the Adobe RGB or ProPhoto 
RGB color spaces.

16-bit output increases the color graduations from black to white in 
each of the three color channels from 256 in 8 bit output, to 65,536 
per channel in 16-bit. This makes a huge difference in the way that an 
image can be adjusted without visible damage. It also prevents banding 
on gradients, such as skies.

12.1 How can I create a process recipe?

Process Settings consist of a selection of options to create and output 
images as required. The Process Settings Tool tab provides many 
choices for the output of your images. 

Here is a summary of what each setting does:

Format
Choose the output file format, depending on the determined use of the 
file. 

TIFF for maximum quality or JPEG for size and convenience.

TIFF files provide the option of 16 bit output.
 

Example of output recipe for compressed TIFF 
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Compression
Both TIFF and JPEG files may be compressed.

TIFF is lossless format, as are both forms of TIFF compression; LZW 
and ZIP. This is the best choice for pixel based image archiving.

JPEG is a compressed file, the higher the compression, the smaller 
the file. However, the higher the compression, the greater the loss of 
information from the file. JPEG compression also adds noise to an image.

The following settings are recommended for JPEG Quality Image 
Options. Choose 90 or above for glossy magazines. Choose 80 or 
above for any other printed form.

Colorspace
Choice of Color space depends on the final purpose of the file.

For web use, the only choice is sRGB, for other uses check with your 
client or lab. Adobe RGB is often recommended.

Resolution
Resolution is typically 300 px/in, but again, for web this will be 72 px/in 
and many processing labs will have different requirements.

Example of output recipe for web 
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What is JPEG QuickProof™?
The JPEG QuickProof format, will create ultra quick images for evaluation 
purposes, in short, Capture will create the image file, from the proxy file 
and the settingsfile, without additional calculations or filters.

JPEG QuickProof is therefore not to be considered a completed file, 
merely a file for evaluation purposes. 
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Example of output recipe for print 

Size
The default setting for scale is Fixed, 100%. This setting can be changed 
as required.

The options “To Width” and “To Height” are self-explanatory. “To size” 
option is not so.

The best way to understand the “To size” option is by example. For 
instance you have a group of images to be processed for the web. The 
area that the image must fit is 500 x 500 pixels. 

The best way to accomplish this request is to choose “To size” and 
set the dimensions 500 x 500 pixels. Navigate through the images and 
crop them as desired. 

When these files are processed the dimensions will be 500 x 500 pixels 
and will satisfy the specific processing request.

The “To size” option is available when the crop tool is set to output. For 
example the output size is set to 10 x 8”. Navigate through the images 
and crop to output. The images will have a 10 x 8” crop applied.

This technique can also be applied when cropping with the crop tool 
set to fixed ratio.

All of these examples will give accurate output and quicken the rate at 
which you work. 

Output Scaling
New to capture One 5 is the ability to scale images on output from  
10-250%. 

Previously only available in the Pro version of the software, this means 
that upsizing images is as simple as selecting the output size required. 
Because the scaling is carried out on the original data, the scaling is of 
the highest quality and suitable for any type of use.
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Open with
Allows Capture One to automatically opening the processed file in an 
application. Most users choose Adobe Photoshop™ to open the file 
immediately after processing.

The best practice when processing a batch of files is to set “Open 
with...” to None. This will prevent computer related resources from 
being depleted.

Naming
Output naming provides a range of options for naming the processed 
files. Adding a job name in the blank field increases these options 
and the helpful sample panel provides a preview of how the chosen 
convention will work.

Process destination
Beneath naming, is the heading ‘Location’. This is where you choose 
the output destination for processed files. Click on the button and 
navigate to a suitable folder. This can be on a local or networked drive. 
This can also be set on the output location on the Library Tool tab.

Process Summary
The Process Summary window provides an overview of all the settings 
chosen for an image before processing. 

This includes the actual and final processed size, name, format and  
file size.

Clicking Presets provides a choice to process the primary or variant 
image.

When you press the Process button, the file or files will start processing 
the Primary Capture automatically. 
Output to DNG
Many see a benefit of using DNG for archival purposes.

Outputting to DNG format in Capture One in essence creates a new RAW 
file. There are no options for size or compression with this format. All 
changes made to the image will be discarded when creating the DNG file.
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Feature

12.1 Multiple Recipes

Often you will need the same image in different variations, an 
editable and printable 300DpI, a web version 72DpI created to 
match with etc. This can be done very easily as your process 
recipe is automatically saved in the recipe profiles on top of 
the tab.

When you are done creating your output recipe you can name it and 
then press “+” to add the next recipe. Each new recipe is based on the 
previous settings. This way you can create more than 1000 of different 
process recipes, which should be sufficient for most photographers.

It is important to notice, you do not have to save changes in the process 
recipe, the changes you make, are automatically added to the process 
recipe that is high-lighted.

Through time you will find it practical to create many different recipes, 
a clever system could be naming after client name, or purpose… you 
can choose to only view the selected recipes, this makes it easier to 
verify that the right recipes are selected.  The images created in the 
batch appears as one image referring to the rawfile, but if you, as this 
example have chosen to create several images from one rawfile, the 
images will simply be placed in the chosen output folder 
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Can I output to different folders?
By using advanced tab in the process recipe you can decide how the 
files of the individual recipe should be stored. The folder will be created 
automatically when process button is pressed. 

You can even decide to have the individual process recipes stores in their 
own specific subfolders, using the advanced tab on the process recipe.

This way you avoid having to sort and split up files from the job before 
shipping them to your client, or to the different post process places.

Can I convert to other than RGB profiles? 
You can convert to various different RGB and CMYK workspaces by 
deciding in the process recipe, it is of course always recommendable 
to convert and check the colors thoroughly before processing. 

You can also change to CMYK in View>Proof Profile, in this menu you 
will find the same colorspaces as in the process recipe. This way you 
can do your adjustments in the CMYK image keeping an eye on the 
final result 

CMYK Values
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12.2 WATERMARK

How can I secure my image?
It is always a risk handing images to a client. Many 
photographers have experienced that clients use the images 
without permission. This can be hard to avoid, but you can 
make illegal usage of the images more difficult by using watermarks.

Watermarks are your way of making a non-removable personalized 
mark on your image, as default your process recipe will not print a 
watermark, but next to the advanced tab you find the watermark tab, 
change Kind to text, and you can add the text needed “My Photo” you 
can of course adjust font, color, opacity and placing, and you can scale 
the image or text watermark to fit the image file.

Can I add a logo as watermark?
Watermark is not just text; open the scroll-down menu “TYPE” 
and select image. You can now browse to your image file or simply 
drag’n’drop the imagefile directly into the watermark field from your 
Mac or PC, you are able to see the selected logo in the image area and 
e.g. adjust opacity and placing. – If you want to adjust alignment of the 
logo file you can select the hand tool below the image field and you can 
adjust the logo or image file.



130

PRO
Feature

What image files can be used as Watermark?
In general you can use any file that has a MAC/PC recognizable thumbnail 
embedded, this includes the most common files such as, jpeg, gif, png, 
EPS – and photographic files if the proper codec is installed. Read 
more on image codecs on the relevant camera producer’s website.

Why is my watermark on all images?
The watermark is added to the individual process recipe – when the 
process recipe is check-marked, the effects of this recipe will be shown 
on all images – also the watermark – the watermark is visible on all 
image files until you remove the highlight from the process recipe.

Can I use watermark to protect my Web Contact Sheet?
The watermarks will be on all processed images and also on your web 
contact sheets, to protect the files you are sending to your clients – the 
watermarks cannot be removed from the processed file or from the 
web contact sheet.
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12.3 Create Web-Contact sheet

To output a group of images to a web based contact sheet, select the 
images and choose File > Make Web Contact Sheet.

A dialogue presents itself offering the opportunity to provide information 
such as title, description, etc.

The best practice is to choose the dark grey background color. Light 
grey background color option is also available, if preferred.

An amazing feature of the web contact sheet is that the size of the 
images and thumbnails can be customized. If you have access to a 
secure server or a password-protected web folder, it makes sense to 
preview images to clients at 800 pixels so they can see the quality of 
the images. You can see the pixel size of thumbnails or preview size 
when adjusting the slider, the number indicates how many pixels the 
images are wide.

Once all options have been selected, choosing Export outputs a 
complete folder to add to your web site.

It is important that the name is in lower case and without spaces – you 
can use hyphens or underscores.

Tip:
When generating a Web 
Contact Sheet, Capture One 
uses the generated proxies in 
order to achieve a much faster 
result. However, if the proxies 
have not been generated yet, 
the Web Contact Sheet must 
wait for this to happen. This can 
take quite some time, so if you 
are experiencing slow progress 
in the sheet, missing proxies is 
most likely to be the reason.

Tip:
When asked for a name after 
export, remember that the 
name you choose will be the 
folder name and will appear on 
your web site – for example:
www.adomain.com/foldername
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Can I add/disable sharpening for my contact sheets?
No, sharpening can be applied to the images themselves, not to the 
web contact sheet as a whole.

What is the best workflow to adjust exposure for images for web?
The most effective way to adjust images quickly for output is to fine 
tune exposure and contrast, then copy the settings and then to select 
all similar images and paste the settings to them.
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12.4 How does the batch work?

After the output recipe is created mark the files to be processed. Now 
choose File>Process, or press Process button. The batch of files will be 
processed to the selected output folder.

If you wish to Process all selected instead of just one, first select the 
images you wish to process then press Process or choose File>Process.  

Capture One has been designed to process batches of images quickly 
and efficiently. 

The Batch of files will start processing immediately after choosing 
File>Process or Process button.  

Batch processing can work in two ways depending on your preference:

By default, processing happens in the background without noticeable 
effect on the performance of the application.

There is the option to stop the batch queue, only enabling it to process 
images when other work has finished or overnight. 

To set the application to work in this way, go to the Batch Tool tab. 
At the bottom of the tab, press the ‘Stop’ button. Processing will not 
commence until this has been reset to ‘Start’.

When there are a large number of images in the batch queue, processing 
priority can be changed by dragging and dropping unprocessed files 
around in the queue.

You can always remove files from the batch queue by marking the file 
or files and pressing backspace(mac).

History
The batch tool tab shows a history of all recent files that have been 
processed. If for any reason, there is a need for further copies of these 
images, the relevant ones can be selected and the ‘Reprocess’ button 
selected.
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13.0 .EIP Enhanced Image Package

13.1 What is .EIP?
Enhanced Image Package, is a convenient way of packing your master 
file for a true Capture One user based workflow. The image file will be 
seen exactly as you created it. The original untouched RAW file will be 
packed with your setting file, ICC and LCC profile. 

Basically the .EIP in practice is packing the above mentioned files. As 
.EIP is not copying the files, you will not need more disk space. You will 
find the .EIP in the same folder as the RAW file was placed and the .EIP 
will show the very same name as the RAW file originally had.

13.2 Does .EIP have any effect on the final result?
NO – when the .EIP is opened by Capture One on your clients computer 
the .EIP will be exactly the same quality and look you created – as the 
.EIP merely is the original RAW file and the relevant settings files. The 
.EIP is cross platform, so you do not have to worry about PC/MAC 
issues.

13.3 I saved as .EIP - what happened to my image file?
Your image file is now integrated in the Enhanced Image Package, the 
.EIP is simply replacing your image file, at the same time the setting 
files will be removed from the relevant folders to also be included in the 
package.
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13.4 How can I transfer a RAW file including the settings?
You can do this is by packing the RAW file into an .EIP file and transfer 
the .EIP file. Please notice you will not achieve a smaller file size by 
packing in .EIP – it is a non-compressed format created merely for 
Capture One workflow.  

13.5 Can I use .EIP on any type of RAW file?
.EIP is supporting RAW files from any Phase One back.

13.6 How do I unpack the .EIP when received?
You don’t have to unpack the .EIP, the Enhanced Image Package can 
be read and further prepared in Capture One. 

As .EIP is created to make your workflow easier, you can keep the RAW 
file and settings file together through your workflow and still be able 
provide a full quality file for your client or partners in the process. 

After packing your .EIP file you can rename your file in any way you 
prefer, the setting will still be applied to the file.

If you have received an .EIP file and you prefer to keep the file in the 
well-known Capture One structure you can open the file in Capture 
One, and select File>Unpack EIP – then Capture one will automatically 
unpack the files in place in your active session.

13.7 Can I automatically convert my workflow to EIP?
In preferences you can choose to automatically to convert all images in 
future imports to be converted to .EIP the same way you can in decide 
to do EIP tethered photography from your Phase One digital back.
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14.0 Working in other than RAW

Capture One is now supporting and editing JPEG and TIFF files, these 
well known image formats have for years merely been a product of 
Capture One, but many dslr and smaller digital cameras today create 
JPEG in a very high quality, and this can be further adjusted and 
improved in Capture One.

What is JPEG?
JPEG is short for Joint Photographic Experts Group, and are a 
compressed format that in definition is a lossy-format, meaning you 
will loose some of the original informations in the image file, but on the 
other hand you will have a file much smaller than TIFF or RAW. Jpeg 
organization = http://www.jpeg.org/

What is .TIFF?
Tagged Image File Format; a popular lossless format, providing high 
color depth, and loads of graphical possibilities, TIFF files are known 
as an output format but are now supported by most graphical and 
photographical applications.

14.1 Can I do Tethered JPEG session?
YES, tethered sessions are possible for any of the supported cameras 
and in any supported image formats including JPEG. 

But the software controls are and image quality is however limited 
compared to shooting in RAW format
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14.2 What will the quality be when I process jpeg from jpeg?
Creating new jpegs from your capture jpegs can work, just keep in 
mind that the more times you compress files, the more information is 
lost, and 80% of 80% is not a good idea – this way you will end up 
having a lower quality of the processed file – still always remember that 
the original jpeg file is not in any way touched by you creating another 
jpeg file.

14.3 How does White Balance work on other than RAW file?
JPEG and TIFF are files already processed to a certain level, either in 
cameras internal software or in conversion software such as Capture 
One. When the file is found by Capture One the white balance in the 
image will be the white balance from the camera or conversion software 
that originally created the file.

The white balance sliders in Capture One is default set to 5000(Kelvin) 
and 0(Tint) to allow a significant change of the overall white balance, 
the numbers will however not be comparable to a white balance setting 
from a RAW file as the RAW file have a build-in white balance reference 
in the file. 

You can still adjust White Balance but please notice a jpg or tiff file 
usually has a significant smaller dynamic area compared to RAW, this 
might result in burned or darkened areas if you use the auto White 
Balance or the White Balance Picker tool.
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Function	 Mac	 Windows

Select All	 CMD+A	 Ctrl+A
Deselect All	 Shift+CMD+A	 Ctrl+Shift+A
Inverse Selection				    Ctrl+I

Select Previous	 CMD+Left	 Ctrl+Left
Select Next	 CMD+Right	 Ctrl+Right

Set Compare Item	 Return	 Return
Clear Compare Item	 CMD+Return	 Shift+Return
		
Next Tool Tab	 Option+CMD+left	 Ctrl+Tab
Previous Tool Tab	 Option+CMD+left	 Ctrl+Shift+Tab
		
Browser Visible	 CMD+B	 Ctrl+B
Browser Toggle Position	 Shift+CMD+B	 Ctrl+Shift+B
Browser Auto/Man mode	 Option+CMD+B
		
Tools Toggle Visible	 CMD+T	 Ctrl+T
Tools Toggle Position	 Shift+CMD+T	 Ctrl+Shift+T
Tools Toggle Auto	 Option+CMD+T

Undo	 CMD+Z	 Ctrl+Z
Redo	 Shift+CMD+Z	 Ctrl+Y 

Navigationwindow when zooming	Space	 Space
		
Help				    F1
Show preferences	 CMD+, (comma)	
		
Hide Capture One	 CMD+H
Hide Others	 Option+CMD+H

Quit	 CMD+Q	 Alt+F4

Edit Primary Only	 Shift+CMD+E	 Shift+CTRL+E
AutoAdjust	 CMD+F	 Ctrl+F
Reset Adjustments	 CMD+R	 Ctrl+R

Capture One 5 – Keyboard Shortcuts
Function	 Mac	 Windows

MoveToTrash	 CMD+Backspace	 CTRL+Delete
Delete permanently	 Shift+CTRL+Backspace	 Alt+Del

MoveTo	 CMD+J	 Ctrl+J

Capture 	 CMD+K	 Ctrl+K
Process	 CMD+D	 Ctrl+D

RotateLeft	 CMD+Option+L	 Ctrl+Alt+L
RotateRight	 CMD+Option+R	 Ctrl+Alt+R
Rotate Snap	 CMD+Option+X	
		
Viewer Zoom In				    Ctrl+Plus
Viewer Zoom Out				    Ctrl+Minus
Viewer Zoom to Fit	 CMD+0	 Ctrl+0
Viewer Zoom to 100%	 Option+CMD+0	 Ctrl+Alt+0
Zoom Window	 CTRL+CMD+Z
Minimize	 CMD+M
		
New Variant		 F2		 F7
Clone Variant		 F3		 F8
		
Copy Adjustments	 CMD+Shift+C	 Ctrl+Shift+C
Apply Adjustments	 CMD+Shift+V	 Ctrl+Shift+V
		
Import Images				    Shift+Ctrl+I
Capture 	 CMD+K	 Ctrl+K
		
Exposure Warning Toggle	 CMD+E	 Ctrl+E
Show Grids and Guides	 CMD+G	 CTRL+G

New Session	 CMD+N
Open Session	 CMD+O	 CTRL+O
Close Window	 CMD+W

Activate Viewer		  F10
View in full screen		  F11
Multi Image Viewer		  CTRL+M
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Function	 Mac	 Windows

Remove rating	 0	 0
Rate 1 star	 1	 1
Rate 2 stars	 2	 2
Rate 3 stars	 3	 3
Rate 4 stars	 4	 4
Rate 5 stars	 5	 5

Cursor Tools Shortcuts
Cursortool	 Key
Use Shift to toggle
Select	 V
MoveTo	 V
Trash	 V
Pan	H
ZoomIn	 Z
ZoomOut	 Z
Crop	 C
Rotate	 R
FreehandRotate	 R
LeftRotate	 R
RightRotate	 R
WhiteBalance	 W
HighlightPicker	 L
ShadowPicker	 L
CurvePointPicker	 U
CopyAdjustments	 A
ApplyAdjustments	 A

Capture One 5 – Keyboard Shortcuts

Function	 Mac	 Windows

Tool tab shortcuts
Tooltabs	 Key
Library Tab	 CMD+Option+1	 Ctrl+1
Capture Tab	 CMD+Option+2	 Ctrl+2
Quick Tab	 CMD+Option+3	 Ctrl+3
Color Tab	 CMD+Option+4	 Ctrl+4
Exposure Tab	 CMD+Option+5	 Ctrl+5
Composition Tab	 CMD+Option+6	 Ctrl+6
Detail Tab	 CMD+Option+7	 Ctrl+7
Metadata Tab		  Ctrl+8
Adjustments Tab		  Ctrl+9

Previous Tab	 CMD+Option+	 Ctrl+Shift+Tab
Next Tab	 CMD+Option+	 Ctrl+Tab
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If your mouse or pointing device has a scroll (wheel) function you can 
use it in selected areas to control features of Capture One.

The Viewer
Place your mouse cursor over an image in the Viewer; moving the 
scroll wheel up will zoom into an image and moving the scroll wheel 
down zooms out. You don’t have to have images to selected to zoom 
in or out.

The Browser
If you place your mouse cursor anywhere in the Browser you can 
scroll up and down in your image collection by using the mouse scroll 
wheel

Sliders and input fields
Place your mouse cursor over a slider in any given tool and you can 
use your scroll wheel to fine-tune the slider settings, by scrolling 
up or down on the mouse. You don’t have to select a slider, simply 
place your mouse cursor over it and start scrolling. You can easily 
move for slider to slider and control to control and make fine-tuned 
adjustments. 

Similarly you can place your mouse cursor over any input field in a 
control and adjust it up or down by using the mouse scroll wheel. 

Curve points
The mouse scroll wheel is a great tool for fine-tuning your curves 
work. Pick curve points and use the mouse scroll wheel to carefully 
adjust these.

Capture One – Mouse Shortcuts
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